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In this example you will learn about: 

• How to determine the applicable storm duration for a project location.  

• Creating a basin, the different basin options, and how to estimate runoff from a 
basin. 

• How to transfer basin information to a report. 

• The Slope Calculator. 
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WWA – Storm DurationWWA – Storm Duration 
Western Washington utilizes the Type 1A 24 hour storm to design conveyance systems.  
The precipitation values are much simpler to determine than for EWA, as noted below. 

1. From the HQ Hydraulics web page, select Links.  
( http://www.wsdot.wa.gov/Design/Hydraulics/links.htm) 

2. Select the Washington 24-hour Isopluvial Maps link and a set of maps for 
Washington will open including the one shown below.  

3. Locate the project on the map and determine the precipitation values for the 6 
month, 2, 10, and 25 year storms.  

4. Input these values into the Project Precipitation table, on the Project Defaults tab, 
in the Project Configuration dialog box.  For this example, we will assume the 
values are the same as in EWA. 
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Example Problem Example Problem 
Develop basins for the before and after conditions using the following description:   Develop basins for the before and after conditions using the following description:   

• A new two-lane roadway section is to be constructed near Seattle, which is in 
Climatic Region 3.   

• A new two-lane roadway section is to be constructed near Seattle, which is in 
Climatic Region 3.   

• The SCS soil type for the entire project is Type C and the ground cover is 
primarily forest in fair conditions. 

• The SCS soil type for the entire project is Type C and the ground cover is 
primarily forest in fair conditions. 

• The existing site condition currently sags in the middle of its length 
(approximately 1800 feet).  It is also about 50 feet wide.  Water generally collects 
at point A and then runs down the basin to point B in a semi-defined ditch.  The 
ground cover is all forested.  The ground generally slopes  

• The existing site condition currently sags in the middle of its length 
(approximately 1800 feet).  It is also about 50 feet wide.  Water generally collects 
at point A and then runs down the basin to point B in a semi-defined ditch.  The 
ground cover is all forested.  The ground generally slopes  

• The calculated time of concentration should be assumed for the forested 
conditions to be 50 feet of sheet flow with the remaining 900 feet as shallow 
concentrated flow to point A.  Finally, runoff concentrates and flows to 50 feet to 
point B. The average slope of the ground before the construction was 1%.   

• The calculated time of concentration should be assumed for the forested 
conditions to be 50 feet of sheet flow with the remaining 900 feet as shallow 
concentrated flow to point A.  Finally, runoff concentrates and flows to 50 feet to 
point B. The average slope of the ground before the construction was 1%.   

• The proposed conditions for the new impervious roadway will be slightly elevated 
and will utilize curb and gutter to control the flow.  The developed site will have a 
sag in the profile (see Figure 3). See the plan and cross section view below in 
Figures 1 and 2 below.  

• The proposed conditions for the new impervious roadway will be slightly elevated 
and will utilize curb and gutter to control the flow.  The developed site will have a 
sag in the profile (see Figure 3). See the plan and cross section view below in 
Figures 1 and 2 below.  

  
  
  
  

PLAN VIEW - EXISTING CONDITIONPLAN VIEW - EXISTING CONDITION 
Figure 1 
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PLAN VIEW – DEVELOPED CONDTIONSPLAN VIEW – DEVELOPED CONDTIONS 
Figure 2 
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Figure 2 
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Figure 3 
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Creating a New File 
When StormShed 3G is opened, it will automatically open to the last file used.  The first 
step for this example is to create a new file.  Select File>New and input a unique name 
that will easily remind you of the project.  For this example, call the New Project Name: 
basin.  Then click on Ok. 

  
The 3G project disclaimer dialog will appear as shown below.  This is just a reminder 
that this is technical software and while the software developer has made every effort to 
eliminate errors in the program, it is up to the designer to use engineering judgment when 
reviewing the results. 

 
Select I Fully Understand and the box will close. 

Set Project Defaults 

After a project is created, the next step is to set the project 
defaults.  In this tutorial we will only modify the items in the 
Project Defaults tab. 

Select Data>Config. 

 

2/15/2008 5 Final 
 



Basins and Design Storms for Conveyance           Section 2 

  

The Project Configuration box will open as shown below. The Project Configuration box will open as shown below. 

  
To eliminate the Warning dialog box; the Design EventTo eliminate the Warning dialog box; the Design Event must be typed as ‘2 year 24 hour’ 
or ‘2yr 24hr’.  If ‘2 year’ is typed, the warning will continue to appear.   

Project Precips – After determining the precipitation values (see the applicable EWA or 
WWA storm determination sections of this tutorial), input the values as shown above.   

• To modify an existing value, highlight the Design Event by LMB click on an item 
and then modify the values in the boxes above.  Accept the change by selecting 
the Update button. 

• To add a new value, input the design event and precip. into the blank boxes, then 
select the Add button.   

For this tutorial we will leave the default selections for AMC, IDF and Tc as shown 
above. 

2
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 Create Basins Create Basins 
First, define the ‘before’ drainage basin conditions.  

 
Expand the Basin option in the Data Tree View and then double click on PROTOTYPE 
to open the basin dialog box.  The PROTOTYPE dialog box is the template for all other 
basin records.  It will save time if repetitive options are set in the PROTOTYPE dialog 
box and saved before creating a new basin or use an existing basin to create a new basin. 

Select the New button and input the basin name, for this tutorial use ‘before’.  Then click 
OK to close the dialog box. 

 
 

Next we will review the input boxes on the first tab, labeled the basin name ‘before’: 

• Rainfall Type – This is where the design storm, as specified in Chapter 4 of the 
HRM, is selected.  For this project, we were told to use the Type1A.RAC for 
WWA. 

• Storm Duration – the length of a storm is set here and the program will either 
stretch or shrink a storm distribution to this time line.  For this example, set the 
duration to 24 hours in WWA. 

2
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• Design Method – designers have three methods to select from for the design 
analysis: SCS, SBUH, or the Rational Method.  Either the SCS or SBUH is 
acceptable on WSDOT projects as both will yield similar results for most 
WSDOT project.  For projects with more pervious surface or in a rural area, 
consider the SCS method and for projects with more impervious surface or in an 
urban area consider the SBUH method.   

• Hyd Interval – or the hydrograph interval.  This is the interval at which data is 
reported from the 3G analysis; this value does not affect the actual analysis.  
When the Type 1A or Long Duration Storm is used, the 10 minute default is 
appropriate.   

• Peak Factor – This feature is not modified for WSDOT projects from the default 
value of 484.  This is a customization feature that will either flatten or heighten 
the hydrograph. 

• Unit Hydrograph – A unit hydrograph basically put represents the affect rainfall 
has on a particular basin.  In 3G there are two options: SCS and Delmarva.  The 
Delmarva only applies to projects in Marylands, so for all WSDOT projects the 
SCS Unit Hydrograph option should be selected. 

• Loss Method – there are three options for determining precipitation losses on a 
project: SCS, Green Ampt, and Holtan.  Generally all WSDOT projects use the 
SCS CN Approach which combines infiltration losses with the initial abstraction.  
The Green Ampt and Holtan method require more information than we usually 
have on a WSDOT project. 

The Perv CN tab is where the pervious drainage basin area is defined by both the total 
area in acres and the Curve Number (CN).  The CN values can be selected from the pull-
down tab based on the land use selected, (Urban, Developing Urban, Cultivated 
Agriculture, Other Agriculture, and Arid Rangeland) and the HSG (Hydrologic Soils 
Group).  Designers should verify these values are the same as found in Appendix 4B of 
the HRM, an example is shown on the next page.  Note there are separate CN tables for 
eastern and western Washington in the HRM, be sure to use the correct table. 

Notice there are values already set up in the PROTOTYPE basin; these are examples of 
how to input data and should be deleted.  Next input the information from the example 
by typing the values in the boxes as shown below and then selecting the Add tab.  To 
modify information already input, LMB click on the data and the information will appear 
in the upper boxes.  Make the necessary changes and then select the Update button.  The 
changes should appear in the lower box. 

• For this example, input the data as shown in the box below. 



Basins and Design Storms for Conveyance           Section 2 

  
• Move to DCIA• Move to DCIA – This option allows designers to move pervious basins to the 

impervious basin tab, a time saver when basins are accidentally input on the 
wrong tab.  Simply highlight the row, select this button, and the basin description, 
subarea, and CN will be moved to the Directly Connected CN tab.  

• Abstraction Coeff – This value can only be modified when using the SCS CN for 
the loss method.  Precipitation has to be greater than 0.2S (the maximum soil 
water retention parameter) before runoff is generated.  While this number can be 
modified in the Pervious CN tabs only, it should be left as 0.2 for WSDOT 
applications. 

• Total Area – The total pervious area entered for this basin is summed in this box. 

• Avg CN – This is the average CN computed based on all the pervious surfaces 
reported. 

Get CN values in Appendix 4B of the Highway Runoff Manual. 

http://www.wsdot.wa.gov/Design/Hydraulics/default.htm 

OR 

Get CN values using drop down boxes and menus. 

2
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Defining the Time of Concentration (TC) is the next step for the pervious surface.  Select 
the Perv TC tab and modify the information as shown on the below using the example 
problem statement summarized below.   

• For this example we have 50ft of sheet flow on a 1% and the land cover type is a 
fair forest condition.  The best match for a sheet flow Kf from the pull down 
menu is, wood or forest with dense under brush. 

• The second type of pervious flow is shallow for a length of 900ft at a 1% slope. 
Select forest with heavy ground litter and meadows for the ns value. 

• The third type of pervious flow is intermittent channel flow for a length of 50ft at 
1% (assumed).    Select forested swale with heavy ground litter for the Kc 
value. 

Again the default values in the PROTOYPE description area are for example and need to 
be either deleted or updated.   
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Now let’s review the options in the Flow TypeNow let’s review the options in the Flow Type pull-down menu.  While there are many 
options we generally only use the ones noted below on WSDOT projects: 

• Fixed – Rather than having the program calculate the travel time, the designer can 
manually input the value. 

• Sheet Flow – Flow, over a relatively flat surface that does not concentrate more 
than 0.1’ deep, and is less than 100’ in length is considered sheet flow.  This type 
of flow will be used to model runoff as it travels off the roadway to the shoulder. 

• Shallow Flow – Once flow exceeds the depth and or length requirements for 
Sheet Flow, it begins to have a defined flow path and is assumed to be Shallow 
Flow.  Runoff traveling along the curb line or in ditches should be modeled as 
Shallow Flow. 

• Channel Flow – Is assumed to begin where surveyed cross section information 
has been obtained, where channels are visible on aerial photographs, or where 
lines indicating streams are shown on US Geological Survey Maps.  There are 
two options for Channel Flow in 3G: intermittent and continuous.  The 
difference between the two is intermittent flow has a lower Hydraulics Radius 
(0.2) than continuous flow (0.4). 

Since in the before condition there is no impervious surface, the next two Directly 
Connected tabs should be left blank. 
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The last tab, Compute Design Event, can be used to quickly compute a flow rate and 
volume of the runoff based on this basins characteristic. 
The last tab, Compute Design Event, can be used to quickly compute a flow rate and 
volume of the runoff based on this basins characteristic. 

• The Select Design Event• The Select Design Event pull-down menu references the precipitation values input 
into the Program Defaults tabs.  For this example, select 25 year.   

• The AMC group can be changed for just this computation when using the 
compute command; it is not a permanent change.  This will only give the designer 
an idea of how a different AMC could affect runoff from this basin.  Note the 
Project AMC that was set in the Project Defaults tab, is also noted here. 

• Select the Compute button for a quick look at the runoff generated from the 
basin.  Using this command does not report the data to the history view; 
instructions for reporting this data are described at the end of this tutorial. 

 

 

Next, the After drainage basin site conditions will be defined (the new impervious 
roadway with curb and gutters).    

• Click on the New button, to create a new basin and then type ‘after’.  To save 
time reselecting the settings, select the ‘before’ basin instead of the prototype 
basin. 

Next, delete any entries in the Perv tabs since in the after condition; the pervious surfaces 
are replaced with pavement.  Or to save time, highlight the pervious basin and hit the 
Move DCIA button.  This will automatically move the basin to the Directly Connected 
CN tab.  Remember to update the Description and CN to reflect an impervious area. 

2
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Directly Connected CN and TC – These tabs were formally known as Impervious CN Directly Connected CN and TC – These tabs were formally known as Impervious CN 
and TC in the older versions of StormSHED.  This is still the location to input 
impervious areas; however the name has changed.  The new name simply describes what 
is happening, that is runoff from impervious areas is directly connected to runoff from 
pervious areas within that basin.  When pervious runoff and impervious runoff are input 
into separate tabs, the program generates two separate hydrographs (one for the Directly 
Connected and one for the Pervious areas) and then the two hydrographs are added 
together.  If a composite CN is more representative of a project site runoff, this can still 
be done by entering both the pervious and impervious areas into the Perv CN and TC 
tabs.  Then StormSHED will generate one hydrograph based on the composite CN.  
Generally two separate hydrographs summed as one, will provide a more accurate 
representation of a project site runoff.  Consider a project with 9 acres of pervious runoff 
directly connected to 1 acre of impervious runoff.  The runoff from the 1 acre of 
impervious area is going to have a faster travel time than the pervious area.     

 
 
2
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Next, select the Directly Connected TC tab.  Each flow path must be defined for the 
impervious area, below is a summary of the example description.  
Next, select the Directly Connected TC tab.  Each flow path must be defined for the 
impervious area, below is a summary of the example description.  

• For this example we were told there is 45ft of sheet flow at a 2% and the land 
cover type is a paved condition.  Thus when defining the coefficient for sheet 
flow, select smooth surfaces

• For this example we were told there is 45ft of sheet flow at a 2% and the land 
cover type is a paved condition.  Thus when defining the coefficient for sheet 
flow, select smooth surfaces from the pull down menu.   

• The second type of flow we have on the site is shallow for a length of 900ft at a 
1% slope.  From the pull down menu select paved and gravel areas as the 
coefficient value.   

 

Need to calculate the slope? Select the Slope Calc button below the Coeff. box 
and the calculator to the left will open.  Next input the runoff length and the up 
and down elevations and select the Compute button.  3G will automatically 
transfer the resulting slope to the slope box for the tab that is open in the basin 
dialog box. 

 
 

Select the last tab, Compute, to quickly compute a flow rate and volume based on 
the after construction basin runoff as shown below.  
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Create a Report 
Once information for each basin is entered, the designer will need to provide this data in 
the hydraulic report.  There is no formal report writing command in 3G, however 
information can be sent to the History View and then copied into a word document.  This 
can be done by: 

• LMB click to select the basin in the Data Tree View. 

• RMB click to open the menu. 

• Then LMB click to select the ‘To History’ option. 

This process should be repeated for each basin. 

 
 

 

 

The History View will open and should look as shown below.  Notice there is information 
on each precipitation value that was entered in the Project Configuration tab as well as 
all the information input into each basin. 
Repeat the process for the ‘after’ basin.  Each item (basin, reach, node, etc) will need to 
be selected individually as described above and copied from the History View into a word 
document.  For larger projects there is a quicker method that will be reviewed in the 
Layout Tutorial. 
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